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Are you upgrading from EndNote 7 (or an earlier version of 
EndNote)? 
 
Those who have used earlier versions of this guide, and the associated 
output styles, should experience no problems when upgrading from 
EndNote 7 (or an earlier version). When EndNote 9 is installed, it 
should preserve your preferences, so the Legal reference type should 
still be available. When you open your library for the first time, you 
will be prompted to convert it into EndNote 9 format. 
 
You can continue to use the output style which you were using before, 
or you can download a new version (see 1.3 below). The only 
difference in the new version of the output style is that it is configured 
to format the Electronic Article reference type, which can be used for 
journal articles which are only available on the web (see 3.12 below). 
 

 
 
1.  INTRODUCTION 
 
1.1  About this Guide 
 
This guide aims to teach you practical techniques for using the Australian Guide to Legal 
Citation (2nd edition) with version 9 of EndNote. EndNote cannot meet all the complex 
requirements of legal citation styles. It does however have limited capacity to format 
legal citations, and it is useful as a database for storing citations. This guide will show 
you what EndNote can and cannot do. 
 
We assume that you have a basic familiarity with EndNote. If you have not yet 
familiarised yourself with EndNote, work through the EndNote Guided Tour in Chapter 
3 of the EndNote manual. The manual forms part of the software and will be installed on 
your computer when you install EndNote. It is a large .pdf file. The default location is:  
C:\Program Files\EndNote 9\EndNote.pdf 
 
We also assume that you are familiar with the requirements of the second edition (2002) 
of the Australian Guide to Legal Citation. It can be viewed on the web at:  
http://mulr.law.unimelb.edu.au/PDFs/aglc_dl.pdf 
 
This guide is written for users of EndNote 9. Users of EndNote 8 will also find it useful. 
It explains how to use EndNote 9 with Microsoft Word (Word 2000 and above).  
 
This guide refers to the Windows version of the EndNote software. The information is 
also relevant to Macintosh users, with only minor variations. 
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1.2  Terminology 
 
The following terms are used in this guide: 
 
"AGLC2" – Australian Guide to Legal Citation, 2nd edition (Melbourne: Melbourne 
University Law Review Association, 2002)  
 
"the output style" – the EndNote output style for the second edition of the Australian 
Guide to Legal Citation which can be downloaded from the University of Queensland 
Library website (see 1.3 below). 
 
"the EndNote manual" – the manual for the EndNote software (see 1.1 above). 
 
1.3  Downloading the Output Style 
 
The EndNote output style to be used with this guide can be downloaded from the 
University of Queensland Library website at: 
http://www.library.uq.edu.au/endnote/styles.html 
 
Note that there are two versions of the style: 
 

• Footnotes Only  Use this version for writing short documents, e.g. journal 
articles 

• Footnotes plus Bibliography  Use this version for writing longer works which 
require a bibliography at the end, e.g. theses and books. 

 
Follow the instructions on the webpage to download one or both versions of the style. 
Macintosh users should read the note on the webpage about making compatible copies of 
the styles. 
 
Once you have downloaded the style, mark it as one of your favourites. To do this, go to 
EndNote, and click on Edit on the menu bar. Then click on Output Styles>Open Style 
Manager. This will display all the styles in your Styles folder. Find the AGLC2 output 
style which you downloaded, and check the box beside it to mark it. Close the Style 
Manager by clicking on the X button in the top right-hand corner of the Style Manager 
window. 
 
1.4  Displaying the EndNote Toolbars 
 
We recommend that you use the EndNote toolbars, which give you faster access to 
common functions. In this guide, we shall be referring to these toolbars. 
 
To display the toolbars in EndNote, click on Tools on the menu bar. Then click on Show 
Toolbar and check all three toolbars. 
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2.  SETTING UP A CUSTOM REFERENCE TYPE 
 
2.1  Why a Custom Reference Type? 
 
The output style that you have downloaded does not make use of the EndNote legal 
reference types (Hearing, Bill, Statute, Case, Legal Rule/Regulation), and if you have 
entered data in your EndNote library using those reference types, the output style will not 
format them. The reason for this is that the formatting of a citation for a statute, case, etc. 
varies according to the jurisdiction. So you would need reference types for Australian 
Statute, UK Statute, Canadian Statute, US Statute, etc.  
 
Instead, the output style uses a single Legal reference type. Using this reference type, you 
must enter the citation formatted according to AGLC2 (see 3.13 below). This reference 
type is a custom reference type which you must now set up. Follow exactly the 
instructions given below. The output style will not format your references correctly 
unless the Legal reference type is set up as shown. 
 
2.2  How to Set Up the Legal Reference Type 
 
You have two options: 
 
• Download a file from the UQ Library website which will automatically set up the 

Legal reference type. This is the recommended option, but it will overwrite any 
modifications which you have already made to your EndNote reference types. See 2.3 
below. 

 
• Modify the reference types in EndNote yourself. This requires more time, but it will 

preserve any modifications which you have already made to your EndNote reference 
types. See 2.4 below. 

 
2.3  Downloading the RefTypeTable File 
 
This is the easiest way to configure EndNote so that you can use the custom Legal 
reference type. 
 
In EndNote 8 and later versions of EndNote, the reference types are controlled by an 
XML file called RefTypeTable which is stored in the user’s Application Data folder. If 
more than one person is using EndNote on the same computer, each user can have 
separate settings for reference types. 
 
2.3.1  Instructions for those using Windows  
 
Windows users must save the file in their EndNote Application Data folder. This is a 
hidden folder. To display all the hidden folders on your computer, first go to Windows 
Explorer by doing a right click on the Windows Start button and selecting Explore. In 
Windows Explorer, click on the Tools option on the top menu bar, and select Folder 
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Options. When the dialog box opens, click on the View tab. In the Advanced Settings 
box, check the option Show hidden files and folders. Then click on the OK button. 
 
The RefTypeTable file to be used with this guide can be displayed on the web at: 
http://www.library.uq.edu.au/endnote/aglc2/RefTypeTable.xml 
 
Use the File>Save As command to save it to your computer. You must save it in the 
following folder:  
C:\Documents and Settings\[your user name]\Application Data\EndNote 
 
 

 
 

Figure 1: Saving the RefTypeTable File 
 
You will be asked to confirm that you wish to replace the exisitng RefTypeTable file. 
 
The next time that you start EndNote, these changes will become effective.  
 
2.3.2  Instructions for those using a Macintosh  
 
The RefTypeTable file to be used with this guide can be displayed on the web at: 
http://www.library.uq.edu.au/endnote/aglc2/RefTypeTable.xml 
 
Save it to your computer. You must save it in the following location: 
user/library/application support/EndNote 

 5

http://www.library.uq.edu.au/endnote/aglc2/RefTypeTable.xml
http://www.library.uq.edu.au/endnote/aglc2/RefTypeTable.xml


2.4  Modifying the Reference Types 
 
This is the alternative procedure if you have not downloaded the RefTypeTable file as 
explained in 2.3 above. 
 
This procedure will allow you to keep any modifications which you have already made to 
the EndNote reference types. Bear in mind that the output style will ignore any of those 
modifications: it is only configured to format the reference types described in this guide. 
 
Click on Edit on the menu bar. Then click on Preferences. 
 
When the EndNote Preferences window opens, click on Reference Types in the left-
hand frame. Now in the right-hand pane, click on the Modify Reference Types button. 
 
This will open the Modify Reference Types window. The output style is configured to 
format a custom reference type in place of the Unused 1 reference type. 
 
In the Reference Type box at the top of the window, use the drop-down menu to select 
Unused 1. This will display the blank Unused 1 reference type. 
 
Click in the top box and change Unused 1 to Legal. 
 
In the box which corresponds to Year in the Generic reference type insert Year. 
 
In the box below (the Generic Title field) type AGLC Citation. 
 
In the box below (the Generic Secondary Author field) type Jurisdiction. 
 
Scroll down to the box that corresponds to the Generic Label field and type Label. 
 
Fill in the next five boxes with the same names as the Generic reference type: Keywords, 
Abstract, Notes, Research Notes, URL. 
 
It is essential that you enter this data correctly. The output style will not format your 
references if you have not set up the reference type correctly. If you scroll through all the 
fields, they should look like Figure 2. 
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Generic Legal 

Author  
Year Year 

Title AGLC Citation 

Secondary Author Jurisdiction 

Secondary Title  
Place Published  
Publisher  
Volume  
Number of Volumes  
Number  
Pages  
Section  
Tertiary Author  
Tertiary Title  
Edition  
Date  
Type of Work  
Subsidiary Author  
Short Title  
Alternate Title  
ISBN/ISSN  
Electronic Resource 
Number 

 
Original Publication  
Reprint Edition  
Reviewed Item  
Custom 1  
Custom 2  
Custom 3  
Custom 4  
Custom 5  
Custom 6  
Custom 7  
Accession Number  
Call Number  
Label Label 

Keywords Keywords 

Abstract Abstract 

Notes Notes 

Research Notes Research Notes 
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URL URL 
Link to PDF  
Author Address  
Image  
Caption  
Access Date  
Last Modified Date  
Translated Author  
Translated Title  
Name of Database  
Database Provider  
Language  

 
Figure 2:  Legal Reference Type 

 
Once you have entered the fields shown above, you can enter additional fields for your 
own use, if you so wish. Bear in mind that the output style will ignore any data entered in 
such fields. 
 
Click on the OK button to confirm these changes. 
 
This will return you to the EndNote Preferences window. Click on the OK button to close 
this window. 
 
 
3.  ENTERING DATA INTO YOUR LIBRARY 
 
3.1  "Garbage In, Garbage Out" 
 
For the output style to format your references correctly, the data must be entered 
correctly in your EndNote library. The following sections explain how to do this. Firstly 
we give instructions which are applicable to all types of references, and then we give 
further information for specific reference types. 
 
The output style will only format data which has been entered in the fields listed in 3.2-
3.13 below. You can enter data in other fields, but that data will not appear in the 
formatted reference in your document. You can, of course, edit the output style to include 
data from other fields. 
 
When you open a New Reference window so that you can insert data, the default 
reference type is Journal Article. If you are entering many references which are not 
journal articles, you can save time by changing the default reference type. To do this, 
click on Edit on the menu bar. Then click on Preferences. When the Preferences window 
opens, select Reference Types in the left-hand frame. You will now be able to change 
the Default Reference Type using the drop-down menu on the right-hand side. 
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3.2  All Reference Types 
 
3.2.1  Author 
 
Enter the author's name as it appears on the publication. Note that initials should be 
entered with spaces and no stops, e.g. 
Campbell, Enid 
Hart, H L A 
 
Include 'Sir', 'Dame', peerage titles and judicial titles (AGLC2, 1.13.1-1.13.2) in the 
author field, e.g. 
Mason, Sir Anthony 
Kirby, Justice Michael 
 
The output style will correctly format author names which include such titles. However if 
you format your references with certain other output styles (e.g. AGPS), the title will be 
regarded as a forename and will be formatted accordingly. 
 
If there is more than one author, enter each author on a separate line. We recommend that 
you enter the names of all authors, as some other bibliographic styles require that all 
authors be listed. If there are more than three authors, the output style will just list the 
first author, followed by 'et al'. 
 
If the author is a corporate body (e.g. a Law Reform Commission or other government 
agency), enter the name of the body in the Author field, without abbreviation. Remember 
that EndNote requires that all names of corporate authors should be followed by a 
comma. Example: 
Victorian Law Reform Commission, 
The final comma will not appear in the formatted reference unless required. 
 
However, if there is a comma within the corporate name, the comma should be 
duplicated, and no final comma is required. Example: 
Law Reform Committee,, Parliament of Victoria 
The redundant comma will not appear in the formatted reference. 
 
3.2.2  Label 
 
This field is optional unless you want EndNote to create a bibliography at the end of your 
work. If this is the case, see 5.1 below for instructions on entering data in this field.  
  
3.2.3  Pinpoint Citations 
 
If you wish to cite particular pages, paragraphs or sections of the item referred to in your 
reference, you can store that information in the Notes or Research Notes field of the 
reference. These fields can each contain the equivalent of up to sixteen pages of text. If 
that is not enough, you can also use the Abstract field, which can also store up to sixteen 
pages of text.  
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You can use this data when inserting pinpoint citations in your footnotes (see 4.5 below). 
 
3.3  Journal Article 
 
For journal articles which are only available on the web, use the Electronic Article 
reference type (3.12 below). 
 
3.3.1  Author 
 
See 3.2.1 above. 
 
3.3.2  Year 
 
Enter the year of publication in this field. However see the note on Volume below (3.3.5). 
 
3.3.3  Title 
 
Enter the title of the article in this field. Capitalise the first word and all other significant 
words. Do not enclose the title in quotation marks: the output style will do this for you. If 
the name of a case or statute is included as part of the title, you must italicise the case or 
statute name when entering the title. Highlight the case or statute name and click on the 

Italics button  on the Text Style toolbar. (Alternatively, use the standard shortcut 
Ctrl+I to italicise text.) 
 
3.3.4  Journal 
 
Enter the title of the journal in this field, omitting 'The' if it occurs at the beginning of the 
title. Capitalise all significant words. Enter the journal title in full: no abbreviations are to 
be used for journal titles. Do not italicise the title as the output style will do this for you. 
 
3.3.5  Volume 
 
Enter the volume number in this field. If the journal does not have volume numbers, and 
is identified only by year, enter the year here in square brackets and leave the Year field 
blank. 
 
3.3.6  Issue 
 
AGLC2 only requires an issue number for journals where the pagination of each issue 
begins at page one. Where pagination is continuous across the issues of a volume, do not 
enter the issue number. 
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3.3.7  Pages 
 
AGLC2 only requires that the first page number be cited. However we recommend that 
you enter the complete pagination, if you have that information available, e.g. 
123-156 
The output style will cite the first page only.  
 
3.3.8  URL 
 
Do not enter data in this field. If a journal article is readily accessible in printed form, it 
should be cited as a printed item, even if it was viewed on the web (AGLC2 6.14.1). 
 
For journal articles that are only accessible on the web you should use the Electronic 
Article reference type (see 3.12 below). 
 
3.4  Book 
 
If the book is a collection of contributions published under editorial direction, use the 
Edited Book reference type (see 3.6 below). 
 
The Book reference type can normally be used for parliamentary papers, parliamentary 
committee reports, Command papers and reports of royal commissions and law reform 
commissions. For such materials, the notes above on corporate authors (3.2.1) are 
particularly relevant. 
 
3.4.1  Author 
 
See 3.2.1 above. 
 
3.4.2  Year 
 
If the book is a multivolume set published over a range of years, enter the first and last 
years if the work is complete, e.g.  
1970-93  
 
If the publication is still in progress, enter the first year, followed by a hyphen, e.g.  
1993- 
 
3.4.3  Title 
 
Capitalise the first word and all significant words. Do not italicise the title: the output 
style will do this for you. 
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3.4.4  Series Title 
 
This field should be completed for Parliamentary Papers, Law Reform Commission 
reports and other publications where the series title and number are particularly important 
in identifying the work. Enter the title of the series and the number, e.g. 
Report No 40 
Parl Paper No 142 
Cmnd 1749 
 
3.4.5  Edition 
 
Enter only the ordinal number; the output style will add “ed” afterwards. AGLC2 requires 
that you superscript the ordinal suffix. To do this, highlight the suffix, and then click on 

the Superscript button  on the Text Style toolbar. The field will now look like this: 
2nd 

 

If there is no edition number, you can insert other appropriate text, e.g. 
revised 
 
3.4.6  City and Publisher 
 
This data is not required by AGLC2. However if you have this information available, we 
recommend that you enter it in your reference, in case you later need to use the reference 
with a different bibliographic style. The output style will ignore this data. 
 
3.4.7  Volume 
 
The output style is not configured to format data on specific volumes. We recommend 
that you store details of pinpoint references in the Notes field (see 3.2.3 above). 
 
3.5  Book Section 
 
3.5.1  Author 
 
See 3.2.1 above. 
 
3.5.2  Year 
 
Enter the year of publication in this field. 
 
3.5.3  Title 
 
Enter the title of the chapter or section. Capitalise the first word and all significant words. 
Do not enclose the title in quotation marks: the output style will do this for you. 
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3.5.4  Editor 
 
Enter editor names in the same way as author names (see 3.2.1 above). Do not add any 
abbreviations like "(ed)" after the names. The output style will supply these. 
 
3.5.5  Book Title 
 
Capitalise the first word and all significant words. Do not italicise the title: the output 
style will do this for you. 
 
3.5.6  City and Publisher 
 
This data is not required by AGLC2. However if you have this information available, we 
recommend that you enter it in your reference, in case you later need to use the reference 
with a different bibliographic style. The output style will ignore this data. 
 
3.5.7  Volume 
 
If the section is from a multi-volume work, enter the volume number here. Do not enter 
the abbreviation "vol" as the output style will supply this for you. 
 
3.5.8  Pages 
 
AGLC2 only requires that the first page number be cited. However we recommend that 
you enter the complete pagination, if you have that information available, e.g. 
123-156 
The output style will cite the first page only.  
 
3.5.9  Series Title 
 
If this field is applicable, follow the instructions in 3.4.4 above. 
 
3.5.8  Edition 
 
If this field is applicable, follow the instructions in 3.4.5 above. 
 
3.6  Edited Book 
 
Follow the instructions for the Book reference type (see 3.4 above), but note the 
following point. 
 
3.6.1  Editor 
 
Enter editor names in the same way as author names (see 3.2.1 above). Do not add any 
abbreviations like "(ed)" after the names. The output style will supply these. 
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3.7  Newspaper Article 
 
3.7.1  Reporter 
 
Enter reporter names in the same way as author names (see 3.2.1 above). 
 
If the article is an editorial, enter the word Editorial in the Reporter field. (Note: If you 
subsequently use the reference with another bibliographic style, you may need to move 
the word 'Editorial' into the Title field.) 
 
3.7.2  Year 
 
Enter the year of publication in this field. 
 
3.7.3  Title 
 
Enter the title of the article. Capitalise the first word and all significant words. Do not 
enclose the title in inverted commas: the output style will do this for you. 
 
3.7.4  Newspaper 
 
Enter the full title of the newspaper, including the word 'The' where it appears in the 
masthead. Capitalise the first word and all significant words. Do not italicise the title: the 
output style will do this for you. 
 
If the article appears in a separately paginated section of the newspaper, and the section 
has its own title, the title of the section should precede the title of the newspaper (AGLC2 
6.2.1), e.g. 
Saturday Extra, The Age 
 
3.7.5  City 
 
If the city is outside Australia, add the country, e.g.  
Toronto, Canada 
 
3.7.6  Pages 
 
Enter the page number, or section and page number, e.g. B6 
 
3.7.7  Issue Date 
 
Enter the day and month, e.g. 5 February 
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3.8  Conference Proceedings 
 
Use this reference type only for unpublished conference papers. A published volume of 
conference proceedings should be entered as an Edited Book. A single paper in such a 
volume should be entered as a Book Section. 
 
3.8.1  Author 
 
See 3.2.1 above. 
 
3.8.2  Year of Conference 
 
Enter the year in which the conference was held. The day and month should be entered in 
the Date field (see 3.8.8 below). 
 
3.8.3  Title 
 
Enter the title of the conference paper. Capitalise the first word and all significant words. 
Do not enclose the title in inverted commas: the output style will do this for you. 
 
3.8.4  Editor 
 
This field is not applicable. 
 
3.8.5  Conference Name 
 
Enter the full name of the conference. Capitalise the first word and all significant words. 
Omit "The" at the beginning of the name: the output style will supply this. 
 
3.8.6 Conference Location 
 
Enter the place name, e.g. Sydney 
 
3.8.7  Pages 
 
This field is not applicable. Enter a published conference paper as a Book Section or a 
Journal Article, as appropriate. 
 
3.8.8  Date 
 
Enter the day and month (if known), e.g. 11-12 April 
 
3.9  Thesis 
 
3.9.1  Author 
 
See 3.2.1 above. 
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3.9.2  Year 
 
Enter the year in which the degree was awarded. 
 
3.9.3  Title 
 
Capitalise the first word and all significant words. Do not italicise the title: the output 
style will do this for you. 
 
3.9.4  Academic Department and City 
 
These fields are not required by AGLC2. 
 
3.9.5  University 
 
Enter the name of the university in full, e.g. Oxford University 
 
3.9.6  Thesis Type 
 
Enter only the standard abbreviation for the degree, without stops, e.g. PhD 
 
The output style will supply the word 'Thesis' following the abbreviation. 
 
3.10  Report 
 
Use this reference type for Working Papers (AGLC2 6.8). 
 
3.10.1  Author 
 
See 3.2.1 above. 
 
3.10.2  Year 
 
Enter the year of publication in this field. 
 
3.10.3  Title 
 
Capitalise the first word and all significant words. Do not enclose the title in quotation 
marks: the output style will do this for you. 
 
3.10.4  Institution 
 
Enter the full name of the Institution issuing the working paper. 
 
3.10.5  Report Number 
 
Enter the series title and number of the working paper, e.g.  
Working Paper No 112 
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3.11  Electronic Source 
 
This reference type can be used for web pages. Note that if an item is readily accessible 
in printed form, it should be cited as a printed item using the appropriate reference type, 
even if it was viewed on the web (AGLC2 6.14.1). 
 
For journal articles that are only accessible on the web you should use the Electronic 
Article reference type (see 3.12 below). 
 
3.11.1  Author 
 
See 3.2.1 above. 
 
3.11.2  Year 
 
The year may be difficult to ascertain. Look for a copyright date, often to be found at the 
bottom of the web page. If no year can be ascertained, or if the page is being continually 
updated, leave this field blank. 
 
3.11.3  Title 
 
Capitalise the first word and all significant words. Do not italicise the title: the output 
style will do this for you. 
 
3.11.4  Publisher 
 
If the page being cited is part of a larger website, enter the name of the website here. 
Often this will be the name of the organisation responsible for the website, but it may be 
a title, or both an organisation and a title. If the data in this field would be identical with 
the data in the Author field, leave this field blank (AGLC2 6.14.5). 
 
3.11.5  Access Year 
 
Enter the year in which you viewed the reference, e.g. 2001 
 
3.11.6  Access Date 
 
Enter the day and month on which you viewed the reference, e.g. 18 August  
 
3.11.7  URL 
 
Enter the URL of the web page. Do not enclose it in angle brackets: the output style will 
do this for you. 
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Where the full URL is very lengthy and the document may be easily located from a 
homepage or index page of the website, it is sufficient to enter the URL of the homepage 
or index page (AGLC2 6.14.7). 
 
3.12  Electronic Article 
 
Use this reference type for journal articles which are only available on the web. If a 
journal article is readily accessible in printed form, it should be cited as a printed item, 
even if it was viewed on the web (AGLC2 6.14.1). 
 
3.12.1  Author 
 
See 3.2.1 above. 
 
3.12.2  Year 
 
Enter the year in which the article was first published. 
 
3.12.3  Title 
 
Enter the title of the article in this field. Capitalise the first word and all other significant 
words. Do not enclose the title in quotation marks: the output style will do this for you. If 
the name of a case or statute is included as part of the title, you must italicise the case or 
statute name when entering the title. Highlight the case or statute name and click on the 

Italics button  on the Text Style toolbar. (Alternatively, use the standard shortcut 
Ctrl+I to italicise text.) 
 
3.12.4  Periodical Title 
 
Enter the title of the journal in this field, omitting 'The' if it occurs at the beginning of the 
title. Capitalise all significant words. Enter the journal title in full: no abbreviations are to 
be used for journal titles. Do not italicise the title as the output style will do this for you. 
 
3.12.5  Volume 
 
Enter the volume number (if any). 
 
3.12.6  Issue 
 
Enter the issue number (if any). 
 
3.12.7  Pages 
 
Journals which are only available on the web do not usually have any continuous 
pagination. If such data is available, enter the complete pagination, e.g. 123-156 
The output style will cite the first page only.  
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3.12.8  Date Accessed 
 
Enter the date on which the article was retrieved, in the form: 
29 November 2001 
 
3.12.9  URL 
 
Enter the URL here. Do not enclose it in angle brackets: the output style will do that for 
you. 
 
3.13  Legal 
 
The Legal reference type, which you have set up as a custom reference type (see 2.2 
above), is to be used for Cases, Legislation, Treaties and all other references which do not 
fit into one of the reference types listed above. 
 
3.13.1  Year 
 
This field is optional. The output style will not use it when formatting your references. 
However you may find it useful when searching your library or sorting your references. 
 
3.13.2  AGLC Citation 
 
Enter the complete citation in the form specified by AGLC2. Capitals, italics and 
superscript must be supplied. For italics, highlight the relevant text and click on the 

Italics button  on the Text Style toolbar. For superscript, highlight the relevant text 

and click on the Superscript button  on the Text Style toolbar. 
 
Do not insert a full stop at the end of the citation. You will supply the full stop and any 
relevant pinpoint citation when you insert the reference in your document (see 4.3 
below). 
 
3.13.3  Jurisdiction 
 
This field is optional. However you may find it useful when searching your library or 
sorting your references. You can use the full name of the jurisdiction or a standard 
abbreviation. The output style will not use this data when formatting your references. 
 
3.13.4  Abbreviated and Popular Names: a Note 
 
In repeat citations, it is common to use abbreviated or popular forms of case names 
(AGLC2 2.1.8-2.1.9) and treaties (AGLC2 7.1.7). 
 
In such cases, set up two separate references in your library. In the first reference, give 
the full name of the case or treaty. In the second reference, give the abbreviated or 
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popular name only. In the Notes field of each reference, make a note to remind yourself 
that you have another version of this reference in your library. 
 
When you cite the case or treaty for the first time, use the reference with the full name. 
After inserting the citation (see 4.3 below), type any pinpoint citation, and then type the 
abbreviated name, italicised, in parentheses and single quotation marks. In subsequent 
citations, use the reference with the short form of the name. 
 
If your are writing a longer work and require a bibliography at the end of your document 
(see 5 below), bear in mind that both references (the full form and the abbreviated form) 
will appear in the bibliography. When doing the final editing, turn the abbreviated 
citation into a cross-reference to the full citation. 
 
3.13.5  Example 
 
A completed reference for a case would look something like Figure 3: 
 
 

Year: 
1983 
AGLC Citation: 
Lojuk v Quandt, 706 F2d 1456 (7th Cir, 1983) 
Jurisdiction: 
United States 
Label: 
2. Case Law 
Keywords: 
 
Abstract: 
 
Notes: 
 
URL: 
 

 
Figure 3: Sample Reference using Legal Reference Type 

 
3.14  Other Reference Types 
 
The output style is not configured to format any other EndNote reference types. Do not 
use EndNote's Hearing, Bill, Statute, Case and Legal Rule/Regulation reference types. If 
you insert into your paper a reference with a reference type other than those listed in 3.3-
3.13 above, the output style will insert the author's name in the footnote or bibliography, 
followed by a note: Reference type not supported by output style. 
 
Any reference which does not fall into one of the specific types listed in 3.3-3.12 above 
should be entered using the Legal reference type. Follow the instructions given in 3.13 
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above. In the AGLC Citation field enter the citation exactly as it should be cited 
according to AGLC2.         
 
 
4.  INSERTING REFERENCES INTO YOUR PAPER 
 
We now look at some practical issues that arise when you use EndNote in conjunction 
with your word-processor. These instructions apply to recent versions of Microsoft Word 
for Windows. 
 
4.1  The EndNote Toolbar 
 
When working with EndNote in Word, we recommend that you use the EndNote toolbar. 
To display the toolbar, click on View in the Word menu bar, then click on Toolbars, and 
select EndNote … 
 
The buttons on the toolbar will be unfamiliar at first. Sit your mouse on each of the 
buttons, and a text box will appear explaining the use of that button. You can also access 
these commands by clicking on Tools in the Word menu bar, and then clicking on 
EndNote … to display the EndNote submenu. However the toolbar gives you faster 
access to the EndNote functions. 
 
4.2  Disable Instant Formatting 
 
We strongly recommend that you turn off the EndNote instant formatting option (also 
called Cite While You Write or CWYW for short). Many users have found that this 
function is unstable and makes Word freeze, resulting in loss of unsaved data.  
 
On the toolbar, click on the button for Cite While You Write Preferences . When 
the dialog box opens, uncheck the option to Enable Instant Formatting on New Word 
Documents. Click the OK button to confirm this change. 
 
Then click on the Format Bibliography  button on the toolbar. When the dialog box 
opens, click on the Instant Formatting tab. If the first button is labelled Enable, there is 
nothing to change, and you can click on the OK button. But if the first button is labelled 
Disable, click on it and it will change to Enable. Then click on the OK button. 
 
4.3  Inserting References in Footnotes 
 
Follow the instructions in AGLC2 on the position of footnote numbers (AGLC2 1.1.2). 
Position your cursor at the appropriate place in the Word document. Click on Insert on 
the menu bar in Word, and then select Footnote (or Reference then Footnote). When the 
dialog box opens, select the Footnote and AutoNumber options. 
 
Word will create the footnote at the bottom of the screen. If you wish to insert some text 
before the reference, type it first, and then make a space.  
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To insert the reference, you can use the Find Citation(s)  button on the toolbar in 
Word to search your EndNote library and insert the reference.  
 

Alternatively, you can use the Go to EndNote  button on the toolbar and display 
your complete EndNote library. Highlight the reference which you wish to cite, and then 
click on the Insert Citation button  on the toolbar in EndNote. 
 
If you wish to add a pinpoint citation at the end of your reference, see the notes in 4.5 
below on pinpoint citations. 
 
If you wish to cite a second reference in the same footnote, type a semicolon and a space 
before inserting the second reference. 
 
At the end of each reference, type a full stop. 
 
Figure 4 shows how a footnote might appear before the references are formatted. 
 
 

 
3 See, eg, {Pearson, 1993 #23}. 
 

 
Figure 4: Footnote before Formatting 

 
4.4  Formatting the References 
 
You can wait until you have finished writing your paper before you format the 
references, but we recommend that you format the references at short intervals while you 
are writing. This will allow you to check that the references are formatting correctly. 
 
To format the references, click on the Format Bibliography  button on the toolbar. 
When the dialog box opens, your document should be listed in the Format Document 
box. For the option With Output Style, select the style for AGLC2 which you 
downloaded from the library’s website (see 1.3 above). Click on the OK button to format 
the references. 
 
Figure 5 shows how the footnote in Figure 4 will appear after the references are 
formatted. 

 
3 See, eg, Noel Pearson, '204 Years of Invisible Title: From the Most Vehement Denial' 
in Margaret Stephenson and Suri Ratnapala (eds), Mabo: A Judicial Revolution (1993) 
80. 
 

Figure 5: Footnote after Formatting 
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4.5  Pinpoint Citations 
 
After EndNote has inserted the reference into the footnote, you can add a pinpoint 
citation to specific pages or sections. Just type the details into the footnote after the 
reference and before the final full stop. Note that AGLC2 sometimes requires a comma 
before the pinpoint citation, e.g. for journal articles, Australian cases, UK legislation.  
 
Figure 6 shows how the footnote in Figure 4 will appear after a pinpoint citation has 
been added and before the references have been formatted. 
 

 
3 See, eg, {Pearson, 1993 #23}, 92. 
 

 
Figure 6: Unformatted Footnote with Pinpoint Citation Added 

 
For certain citations (e.g. US cases and legislation, international treaties, UN documents) 
pinpoints are inserted within the reference. In these cases, do not use EndNote to insert 
the citation for you. Instead, open the reference in your EndNote library and highlight the 
contents of the AGLC Citation field. Copy (Ctrl+C) this field and paste (Ctrl+V) it into 
your footnote. The pasted text will retain the EndNote font and will have to be amended 
to match the font of your document. Now type the pinpoint citation within the reference, 
as specified in AGLC2.   
 
If your are writing a longer work and require a bibliography at the end of your document, 
bear in mind that EndNote will only include in the bibliography those references which 
you have used EndNote to insert. To include references which you have typed yourself or 
inserted with copy and paste, see 5.2.2 below. 
 
4.6  Omitting Part of a Citation 
 
If you quote the name of a case in the text of your document, the case name should not be 
repeated in the footnote (AGLC2 2.1.10). The footnote will only contain the details of 
where the case report is published, plus any pinpoint citation. 
 
Similarly, if a piece of legislation is mentioned by name in the text, there is no need to 
cite it in a footnote unless further details are required to locate it, or unless a pinpoint 
citation is required. 
 
If the footnote is to contain only part of a citation, just type the required details in the 
footnote, and do not insert the reference using EndNote. You may find it convenient to 
copy and paste some of the details from the AGLC Citation field in your EndNote 
reference. If you want EndNote to format a separate bibliography at the end of your 
document, be aware that this reference will not appear in the bibliography if you have not 
used EndNote to insert the reference somewhere in your document. To include in the 
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bibliography references which you have typed yourself or inserted with copy and paste, 
see 5.2.2 below. 
 
4.7  Repeat Citations 
 
When citing a work that has already been cited in the previous footnote, do not use 
EndNote to insert the repeat citation. Type 'Ibid' or 'ibid' as specified in AGLC2 1.2.1. 
 
When citing a source (other than a case, a treaty or a piece of legislation) that has been 
cited in an earlier footnote (but not the previous footnote), do not use EndNote to insert 
the repeat citation. Type the abbreviated details in the form specified in AGLC2 1.2.2. 
 
Repeat citations for a case or treaty are treated differently. Use 'Ibid' or 'ibid' if the case 
or treaty is cited in the previous footnote, otherwise use EndNote to insert the full citation 
again, and add any pinpoint reference. If you are using an abbreviated or popular name 
for repeat citations to the case or treaty, see the note above (3.13.4) about creating two 
references for the case or treaty in your library. If the repeat citation names the case or 
treaty in the text, the name should be omitted from the footnote (see 4.6 above). 
 
Legislation should be cited in full in all repeat citations (AGLC2 1.2.2). Use EndNote to 
insert the full citation again, and add any pinpoint reference. However if the repeat 
citation names the legislation in the text, the name should be omitted from the footnote 
(see 4.6 above). 
 
4.8  Removing the Field Codes 
 
When you have finished writing your document, and have used EndNote to format the 
references, the final step is to remove the field codes which link the document to 
EndNote. These field codes can interfere with the software used by publishers. 
 
Open your document in Word. On the EndNote toolbar, click on the Remove Field Codes 
button . You will see a message explaining that this command creates a new, unsaved 
document. Click OK to continue. 
 
Save the new document under a name different from that of your original document. The 
original document must be retained, as it is your master copy. Any changes which require 
the insertion, amendment or deletion of references should be made in the master copy. 
You will then have to use the Remove Field Codes command again to generate a new 
unlinked document. 
 
 
5. WORKING WITH LONG DOCUMENTS  
 
If you are writing a longer work (e.g. a thesis or book), you will probably require a 
bibliography at the end of the work, in addition to the footnotes on each page. AGLC2 
gives instructions for the format of such bibliographies (AGLC2 1.15). 
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5.1  Categorising the References 
 
AGLC2 requires that your bibliography be divided according to the type of material. To 
do this, you must enter a category in the Label field of each of your references. The 
output style will sort your bibliography by the Label field, so that the references will be 
grouped in categories. Then references are sorted by the first author, or, if there is no 
author, by title. 
 
In the Label field of each reference, enter one of the categories specified in AGLC2: 
1. Articles/Books/Reports 
2. Case Law 
3. Legislation 
4. Treaties 
5. Other Sources 
 
Figure 3  (above) shows an example of this. 
 
If you are adding the category as you enter each reference, we suggest that you set up a 
term list linked to the Label field. Store the list of categories in the term list. When you 
are entering a reference and reach the Label field, press Ctrl+1 to open the term list. 
Double click on the appropriate category from the term list and EndNote will insert it in 
the Label field. For more information on working with term lists, see Chapter 9 of the 
EndNote manual. 
 
Alternatively, you can add the category to the Label field of multiple references 
simultaneously by using EndNote's Change Field command. Open the library and 
highlight all references which belong to a particular category. Then click on References 
on the menu bar and click Show Selected References to display only those references. 
Now click on References again and click Change and Move Fields. When the dialog 
box opens, make sure that the Change Fields tab is selected. Use the drop-down menu to 
select the Label field. Click the radio button for Replace Whole Field With, and type 
the required text in the box, e.g. 2. Case Law, and then click on the OK button. 
 
When you use the Footnotes plus Bibliography version of the output style to generate the 
bibliography, the references will appear as a single block, grouped according to the 
categories. When doing the final editing of your document, insert some blank lines 
between each category and add an appropriate heading to each group. 
 
5.2  Structuring Long Documents 
 
Long documents can present problems for both Word and EndNote. We will look at four 
possible ways of structuring long documents. 
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5.2.1  Each Chapter as a Separate Document 
 
Keep each chapter as a separate Word document. This procedure is somewhat 
cumbersome, but because the individual documents are not very large, you should avoid 
the problems which can occur with long documents. 
 
Use the Footnotes Only version of the output style to format the references in each 
chapter.  
 
Now create the bibliography as a separate Word document. Open your EndNote library. 
If the library contains only references which you wish to include in the bibliography, just 
press Ctrl+A to select all the references.  
 
Alternatively, you may wish to include only selected references in your bibliography:  
 
• If you have inserted some code into the required references while you were writing 

your paper (for example, XXX in the Notes field), you can Search for all references 
which contain that code. Then press Ctrl+A to select those references. 

• If you have not coded the references, hold down the Ctrl key and go through the 
library, highlighting the required references. Then click on References on the menu 
bar and click Show Selected References. 

 

Once you have selected the references, click on the Sort Library button   on the 
toolbar. This will open a dialog box that allows you to select the fields on which to sort. 
In the first box, select Label. In the second box, select First Author. In the third box, 
select Year. Then click on the Sort button and EndNote will re-sort the references. 
 

Use the Style Manager menu  on the toolbar to select the 
Footnotes plus Bibliography version of the output style. 
 

Click on the Export button  on the toolbar and a dialog box will open. Specify where 
you want to save the bibliography and give the file a name. In the Save as Type box, you 
must select Rich Text Format. 
 
EndNote will format the bibliography and save it as the file which you have designated. 
Open this file in Word. The references should be grouped according to the categories 
which you inserted in the Label field (see 5.1 above). This document is not linked to 
EndNote and contains no field codes, so you can now change the font, separate out the 
categories and add an appropriate heading to each group. 
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5.2.2  One Large Document 
 
Create one large Word document. Bear in mind that both EndNote and Word can 
encounter problems with very large documents. 
 
At the beginning of each chapter, insert a Section break so that each chapter is a separate 
Section. When you insert your first footnote in a new chapter, display the footnote 
options and check the option Restart Each Section. Word will now begin numbering the 
footnotes at 1 in the new chapter. 
 
Use the Footnotes plus Bibliography version of the output style to format the references. 
You may want your bibliography to include some references which you have not directly 
cited in your document, or references which you have typed in yourself or copied-and-
pasted from the reference in the library, without using EndNote to insert the reference in 
the footnote. To make these references appear in the bibliography, proceed as follows: 
 
• Insert a page break at the end of your document. On this new page, insert all the 

relevant references, one after another. It is probably wiser to do this on a continuing 
basis as you are writing the document, but it can be done in one step once you have 
finished writing. 

• In each of the temporary citations, delete the author name (if any) and the year, 
leaving only the reference number, e.g. {#17} 

 
You are now ready to format the references and bibliography. Click on the Format 
Bibliography button on the toolbar. Before formatting, click on the Layout tab. In the 
Bibliography Title box, enter the heading that you would like to appear, e.g. 
Bibliography. Then format the bibliography. 
 
 5.2.3  Master Document and Subdocuments 
 
Set up the chapters as subdocuments within a master document. Use the help screens in 
Word if you are not familiar with this function. Bear in mind that some experienced 
Word users regard the Master Document / Subdocument function as unstable and 
unreliable. 
 
Use the Footnotes plus Bibliography version of the output style to format the references. 
You may want your bibliography to include some references which you have not directly 
cited in your document, or references which you have typed in yourself or copied-and-
pasted from the reference in the library, without using EndNote to insert the reference in 
the footnote. To make these references appear in the bibliography, follow the procedure 
outlined in 5.2.2 above. 
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